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Thank you for purchasing the Power Viewer Software (Model 253734) for the PZ4000
Power Analyzer.
This user's manual contains useful information about the precautions, functions, and
operating procedures of the software. To ensure correct use, please read this manual
thoroughly before beginning operation.
After reading the manual, keep it in a convenient location for quick reference whenever a
question arises during operation.
For information about the PZ4000 Power Analyzer (mainly the precautions, functions,
and operating procedures), see the following manual that is included with the PZ4000
Power Analyzer.

Manual Title Manual No.
PZ4000 Power Analyzer User’s Manual IM253710-01E
PZ4000 Power Analyzer Communication Interface User’s Manual IM253710-11E

For the handling and operating procedures of Windows, see the respective manuals.

Notes

» The contents of this manual describe Power Viewer Software Ver. 2.00. The
operating procedures and screen contents described in this manual may differ from
those in other versions of the software.

» The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the instrument’s performance and functions.

» Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.

« Copying or reproducing all or any part of the contents of this manual without the
permission of Yokogawa Electric Corporation is strictly prohibited.

Trademarks
» Microsoft, MS-DOS, Windows, and Windows NT are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.
» Adobe and Acrobat are trademarks of Adobe Systems incorporated.
» Other company and product names are trademarks or registered trademarks of their
respective companies.

Revisions
» 1st Edition: November 2000
« 2nd Edition: July 2002

Disk No. BA38
2nd Edition: July 2002 (YK)
All Rights Reserved, Copyright © 2000 Yokogawa Electric Corporation

IM 253734-61E 1



Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE

Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric
Corporation (hereinafter called “Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the
“Yokogawa Software Program”).

By opening this package or plastic wrapping (hereinafter called “Package”) enclosing the Yokogawa Software Program, you acknowledge that you
understand and agree to the “Terms and Conditions of the Software License” (hereinafter called “Terms and Conditions”) which is written in the
documentation and separately attached. Accordingly, the Terms and Conditions bind you.

The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa
or those third parties from whom sublicensed software in the Yokogawa Software Program is licensed.

Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions
before you open the Package and/or install it in or onto a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT OPEN THE PACKAGE, AND MUST IMMEDIATELY RETURN IT
TO YOKOGAWA OR ITS DESIGNATED PARTY.

Terms and Conditions of the Software License

Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software
Program (hereinafter called the “Licensed Software”) to the Licensee on the conditions that the Licensee agrees to the terms and conditions
stipulated in Article 1 hereof.

You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called
the “Agreement”) based on the use intended for the Licensed Software.

Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event
shall Yokogawa intend to sell or transfer the Licensed Software to the Licensee.

Licensed Software Name: Power Viewer Software for the PZ4000 (Model 253734)

Number of License: 1

Article 1 (Scope Covered by these Terms and Conditions)

1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the
Licensee consents to agree to the terms and conditions stipulated herein.

1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary
technology, algorithms, and know-how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)

2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the
license fee separately agreed upon by both parties.

2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the
Licensed Software.

2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes. The Licensee shall
secure or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.

2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee
may translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed
Software. Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed
Software.

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which
grants Yokogawa the rights. In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the
Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall the Licensee remove or attempt to remove
such copy protection.

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which
may include any software program from affiliates of Yokogawa made or coded by themselves.) In the case that Yokogawa is granted
permission to sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions
than those stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in
writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software,
including any copy thereof.

Article 3 (Restriction of Specific Use)

3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for
the purpose of the following events:

a) Operation of any aviation, vessel, or support of those operations from the ground;,

b) Operation of nuclear products and/or facilities;,

c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d) Operation of medical instrumentation directly utilized for humankind or the human body.

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or
responsibility for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own
responsibility, to solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any
liabilities, losses, damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims
arising out of and related to the above-said claims and damages.

Article 4 (Warranty)

4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such
as damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any
Licensed Software on condition that the defective Licensed Software shall be returned to Yokogawa'’s specified authorized service facility

4.2

within seven (7) days after opening the Package at the Licensee’s expense. As the Licensed Software is provided to the Licensee on an “as
is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation,
data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms

and conditions that apply shall be those established by the provider of the third party software.
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Terms and Conditions of the Software License

4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted
renovation or improvement of the Licensed Software.

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE,
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD
PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for
any failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing
the Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in
warranty, contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or
arising out of the use of the Licensed Software.

Article 5 (Infringement)

5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under
patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed
Software, the Licensee shall notify Yokogawa in writing to that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate
with the claiming party. Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for
Yokogawa’s defense and negotiation. If and when such a claim should be attributable to Yokogawa, subject to the written notice to
Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s
cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1.

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at
Yokogawa'’s cost and expense.

a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use
the Licensed Software;

b) To replace the Licensed Software with an alternative one which avoids the infringement; or

c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa
shall indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the
Licensee. THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING
THIRD PARTY SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS
INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)

6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided
to the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this
Agreement. However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage,
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue,
loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s
business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of
Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa
and to the extent of this Article 6, Yokogawa'’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software
or service fee which Yokogawa has received. Please note that Yokogawa shall be released or discharged from part or all of the liability under
this Agreement if the Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic
specifications or functional specifications, without Yokogawa'’s prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless
Yokogawa is notified of the claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts
between the Licensee and its customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other
than those where Yokogawa permits export in advance.

Article 8 (Term)

This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa'’s thirty (30) days prior written notice
to the Licensee.

Article 9 (Injunction for Use)

During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems
that the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other
condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to
perform this Agreement. However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)

Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved
amicably through negotiation between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after
notice from one of the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main
office) in Japan for settlement of the dispute.

Article 12 (Governing Law)

This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely
and irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the
Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be
null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.
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Product Overview and Flow of Operation

Product Overview

The PZ4000 Power Viewer retrieves measured data from the PZ4000 Power Analyzer
(PZ) into your personal computer (PC) via communications (GP-IB or RS-232) or files
and analyzes and displays the data. Data can be retrieved from multiple PZs (up to 4
units) into the PC to be analyzed and edited. By combining the file save functions of the
software (in CSV or BMP format) and software applications on your PC, you can create

reports on the measurement and analysis results.
* Only a single unit if the communication interface is serial (RS-232).

The software can be used in two types of modes: online and offline.

Online mode allows you to change the PZ setup from your PC and retrieve and save
setup parameters and measured data of the PZ into your PC via the communication
interface (GPIB or serial (RS-232)).

Offline mode allows you to work, without connecting the PZ and the PC, with data that
was saved to a floppy disk (FD), hard disk (HD), MO disk, or Zip disk by the PZ or this
software program. The data can be loaded for displaying on the PC screen and storing
on a storage medium on your PC.

Online mode Offline mode
Measured data FD. HD Measured data
Setup y 110 Setup parameters
Measured data, parameters MO, Zip
setup parameters
Screen image
PZ PC
GP-IB/RS-232 cable Pz pC
Retrieves measured data from the PZ to be Loads the data measured on the PZ that has
displayed on the screen and saved on a storage been saved to a FD to be displayed on the
medium. Setup parameters, waveform data, screen or saved on a storage medium.

numeric data, and screen image data can be
transferred between the PC and the PZ.
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Product Overview and Flow of Operation

Flow of Operation

The following flow chart illustrates the procedure of operation in online mode and offline

mode.

[set the communication interface| (Section 1.2)

Online

Online or Offline?

(Section 1.3)

Offline

<—| Setup operation of the PZ| (Chapter 4)

Select the display screenl (Section 2.1)

Start measurements (Section 2.1)

Start/Single Start

[ Display measured data| (Section 2.2 to 2.5)

Load setup
parameters

Load numeric data and (Section 3.2)
waveform data

| Display measured data |(Section 2.2 {0 2.5)

| Analyze the waveform datal (Section 5.1)

(Section 3.2)

Stop after one
No End measurement if
” Section 2.1) | the Single Start
measurements? ( ) button was clicked
Yes
Click the Stop button
3

-<—|Analyze the waveform datal (Section 5.1)

| Save to file | (Section 3.1)

Capabilities of the Software

Item

Reference Section

Math computations of up to 4 Mwords.

4.6, “Setting Math”

16 functions of Math computations.

4.6, “Setting Math”

Math computations and X-Y display between
different PZ4000 channels.

2.5, “X-Y display”

Display and extraction of zero crossing data.

4.1, “Setting the Input Module”

Trend display of computed values.

2.4, “Trend Display”

Saving and loading of data retrieved from the
PZ4000, to and from files.

4.9, “Saving the Data and Creating Directories (File)”

Saving the retrieved data in CSV file format.

3.1, “Saving Waveform Data, Computed Values,
and Setup Parameters”

Saving of the screen images to BMP files.

3.1, “Saving Waveform Data, Computed Values,
and Setup Parameters”

Loading of waveform binary files that have been
saved by the PZ4000.

3.2, “Loading Waveform Data, Numeric Values,
and Setup Data”

Control multiple PZ4000s via communications
(GP-1B only).

1.2, “Starting the Software and Configuring
Communications”

Note

This software does not have functions of harmonic measurement mode.
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Types of Files That Can Be Saved/Loaded

The software handles files with .ast, .hdr, .wvf, .fld, .trd, .csv, and .bmp extensions. For
the procedure in saving/loading various data, see chapter 3, “Saving and Loading Data.”

Files with .ast Extension

Files containing setup parameters. The data can be transmitted between the PZ and the
Power Viewer. The setup parameter file of the PZ with .set extension cannot be loaded
into the Power Viewer. Power Viewer requires the setup parameter file when collectively
loading all measured items.

Files with .wvf Extension

Files containing waveform data. The file can be saved and loaded using the Power
Viewer. However, when loading the file, a header file with a same name as the
waveform file must exist in the same directory. The waveform data saved using the PZ
can also be loaded and saved.

Files with .hdr Extension
Header files of waveform data. The header file is required when loading the waveform
data. It is automatically created when waveform data is saved using the Power Viewer.

Files with .fld Extension
Files containing numeric values. The data can be saved and loaded using the Power
Viewer. Computed data (numeric data) saved using the PZ cannot be loaded.

Files with .trd Extension
Files containing trend data. The data can be saved and loaded using the Power Viewer.

Files with .csv Extension
Text data file. The data can be saved using the Power Viewer, but cannot be loaded.
The file can be loaded using application software programs such as Excel.

In addition, the screen image of the Power Viewer can be saved to a file in BMP format.
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PC System Requirements

PC
CPU: Pentium 3 1 GHz or higher

Memory: At least 128 MB*, 256 MB or more recommended
* If the memory size is less than or equal to 128 MB, some of the functions may not
operate.
VRAM: 4 MB or more

HDD: Free space of at least 1 GB (required).

Operating System
Windows 98, Windows Me, Windows NT, Windows 2000, or Windows XP Professional/
Home Edition.

Communication card

RS-232: One open COM port on the PC.

GP-IB (recommended): AT-GPIB/TNT(PnP) by National Instruments and NI-488.2M
driver Ver. 1.60 or later.

CRT, printer, and mouse
Those supported by Windows 98, Windows Me, Windows NT, Windows 2000, or
Windows XP Professional/Home Edition.

PZ4000

Firmware (ROM) Version 2.01 or later

Number of connectable units: 1 when using serial (RS-232) communications, 1 to 4
when using GP-IB communications
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Connecting the PZ4000 to the PC

The following two types of connections are available. Select either one of the connection
methods.

For more details, see the PZ4000 Power Analyzer Communication Interface User’s
Manual (IM253710-11E).

e GP-IB connection
Connect the GP-IB card of the PC and the PZ4000 using a GP-IB cable. You can
connect up to four PZ4000s via the GP-IB interface using this software.
Operation is not possible, if the GP-IB board is not installed in the PC.

¢ Serial (RS-232) connection
Connect the serial port of the PC and the PZ4000 using a serial (RS-232) cable. Use
a cross cable for the serial (RS-232) cable. You can only connect a single PZ4000 via
the serial (RS-232) interface using this software.

Communication Settings on the PZ4000
For the procedure in setting the communication parameters on the PZ4000, see the
PZ4000 Power Analyzer Communication Interface User's Manual (IM253710-11E).

¢ For GP-IB connection
Set the communication settings on the PZ4000 to “GPIB” and set the address to
match that of the software. Make sure to set the address of the GP-IB controller to
“0.”

* For serial (RS-232) connection
Set the communication settings on the PZ4000 to “RS232” and set the following

parameters.

Baud rate: 19200
Data length: 8 bits
Parity: None
Stop bit: 1 bit
Hardware handshaking: CTS-RTS
Terminator: LF

10
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Chapter 1  Installing and Starting the Software and Setting Communications

1.1 Installation

Have the system floppy disk (backup copy) containing the software ready. Exit all
programs that are currently running before starting the installation.

1. Start Windows.

2. Insert the first Power Viewer system floppy disk into the floppy drive.

3.  Select Run from the Start menu, specify Setup.exe that is located at the root
directory of the system floppy disk for Open, and click OK. The InstallShield
Wizard preparation message appears.

Installshield Wizard i

n Powerviewer Setup iz preparing the InstallShield® 'wizard, which
1 will quide pou through the rest of the setup process. Please wait.

ANNNRNNNNNRENR Cancel |

4.  When the InstallShield Wizard preparation completes, the following screen
appears. Click Next to display the Choose Destination Location dialog box.

Installshield ¥Wizard L x|

Welcome to the InstallShield Wizard for
Power¥iewer

suonesunwwo? Bumas pue aiemyos ayy buiels pue buijelsu)

The InzstallShield® wWizard will install Poweriewer on your
computer. To continue, click Mest.

< Hack | Mest > I Cancel |

5.  The default installation destination is set to “C:\Program Files\Yokogawa\Power
Viewer.” Change the destination as necessary. After entering the destination, click
the Next. The software installation is executed.

Installshield ¥Wizard L =

Choose Destination Location

Select folder where Setup will install files.

Setup will inztall Powertfiewer in the following folder.

Ta inztall to this folder, click Mest. To install to a different folder, click Browse and select
another folder.

i~ Destination Folder
C:A\Program FileshyokogawahPoweriewer Browse. . |

IrztalShield

< Back | Mest > I Cancel |
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1.1 Installation

Screen during installation

InstallShield Wizard .

Setup Status

Poweriewer Setup iz performing the requested operations.

Installing:
C:4..A{CO0B2F42-5455-43C1 -AEDF-EEBAC3067CCF Mdatal .cab

O %

IrztalShield

Cancel

6. When the message “Please insert the next disk, Disk 2” appears, insert the second
system floppy disk into the floppy drive and click OK.

Setup Needs The Next Disk |
| Flease insert disk 2 that contains the file data3.cab.
Path:

IA: Browse... |
InztallShield
()8 I Cancel |

7. When the installation completes successfully, the following screen appears.

Click Finish.

InstallShield Wizard

InstallShield Wizard Complete

Setup has finished instaling Poweryiewer on your computer.

< Hack | Finizh I

Lancel

1-2
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1.2

Starting the Software and Configuring
Communications

Starting the Software

1. Choose PowerViewer from the Start menu to start the software.
If you are running the software for the first time after purchase, the program starts
with the communication mode set to offline mode.

v @ Accessories
@ Moderm Helper
Diocuments » (3} Roxio Easy CD Creator 5
Stark
y @ arkup

@ User's Guides

Settings

Search
e Internet Explorer
e [ Outlook Express

Run...

I i start

Note
The software retains the settings that existed when the software was closed the previous
time. If you exit the software in online mode, the software starts in online mode the next time.
In this case, if the communication with the PZ fails such as when the PZ is not turned ON, the
following dialog box appears. To connect in online mode, click Retry; to connect in offline
mode, click Cancel.

PZ4000 Power ¥iewer x| PZ4000 Power Yiewer |

Failed initialization of communications,
& GPIE Initialization Failure

Offline mode will be set when cancel is selected.

i
Retry I Cancel

-0

IM 253734-61E
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1.2 Starting the Software and Configuring Communications

Setting the Connection Method
1. Choose Connection Method from the Communications menu. The Connection
Method dialog box opens.
2.  Select GPIB or RS232.
xl

« GFIB

 RS232

Ok | Cancel I

For GP-IB connection

3.  If you select GPIB, the Communication (GPIB) dialog box used to set the address
appears.
Enter the addresses of PZ4000s that are connected (up to four units). Enter other
unused values for addresses of unconnected PZ4000s. Make sure to enter unique
addresses for PZ4000-1 to PZ4000-4.

l:ommunical:ioi‘r':i ll

PZ4000-1 Address |1_
PZ4000-2 Address |2_
PZ4000-3 Address |3_

PZ4000-4 Address |4_

Cancel |

For serial (RS-232) connection

3. If you select RS232, the Communication (RS232) dialog box used to set the
address appears.
Select the option button of the port to be connected.

Communications{R5232) x|

& COM1  COM2

Setting : 19200BPS, 8-Mo-1, CTS-RTS, LF

cael_|

Note

» In GP-IB connection, device triggers for multi-bus line messages are used to send
measurement start commands to multiple PZ4000s.

» To perform synchronized measurements among multiple PZ4000s, use the combination of
the trigger function of the PZ and the external trigger function. For a description of the
trigger function, see section 7.2, “Selecting the Trigger Source” and 14.1, “External Trigger
Output” in the PZ4000 Power Analyzer User’s Manual (IM253710-01E).
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1.3 Switching the Communication Mode (Online/
Offline)

If you are running the software for the first time after purchase, the program starts in
offline mode. To retrieve data from the PZ and save the data, you must set the
communication to online mode.

Switching from Offline to Online
1. Choose Online from the Communications menu.
The Change online mode dialog box appears.

Change online mode. ] |
EH PZ24000 Power Yiewer
File{F) | Communications(E]  Wiew(y) ;’\i') Load setup from PZ4000 after initialize communication,
[o] Current Communication Setup : GRIE-1, 2, 3, 4
2P offline(F)
o T ‘fes : Load setup from PZ4000,
Conneckion Method() —> Mo 1 Load setup ko PZ4000,
e v GPIBLY
Bz i Yes Mo | Cancel |
£ A e iy

2.  Select the handling of the setup parameters when set to online mode from the

following:
Yes: Loads the setup parameters from the PZ into the Power Viewer.
No: Send setup parameters from the Power Viewer to the PZ.

Note

The software retains the settings that existed when the software was closed the previous
time. If you exit the software in online mode, the software starts in online mode the next time.

Switching from Online to Offline
1. Choose Offline from the Communications menu.
The Change online mode dialog box appears.

El PZ24000 Power Yiewer
File{F} | Communications(E)  View(V} Change online mode, x|
v Onlinedi) -
-
'\19 Finish cammunication.
IV Pz Conneckion Method{M) —
i ,—I
" v GRIE(W) 84 Cancel |
[T E2 - pepasmy

2. Click OK to switch the communication mode to offline.

Note

In offline mode, you can load the file and display and analyze the data. You can also set the
synchronization source for the zero cross setting. For the procedure in setting the
synchronization source, see “When Zero Cross is selected” in section 4.4, “Setting the
Measurement/Computation Period (Measure).” For details on the zero cross setting, see
section 10.1, “Setting the Measurement/Computation Period, Re-computing” in the PZ4000
Power Analyzer User’s Manual (IM253710-01E).
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Chapter 2  Measurement and Display

2.1 Preparations before Loading the Data and
Performing Measurements

Selecting PZ4000s That Will Make Measurements
1. On the PZ Control menu, select the check boxes for PZ4000-1 to PZ4000-4 that
will make measurements. Multiple PZ4000s can make measurements
simultaneously.

FZ Control
¥ PZ4000-1

Select the check boxes of PZ4000 that will make measurements
(Only the number of PZ4000s that are connected are active)

[~ FZ
Single Start
Start
Abort

T
[
I
[

Manual Cal

Selecting the Type of Data to Be Retrieved during Measurement
The types of data that can be retrieved during measurement are computed data and
waveform data.
2. Click the computed value retrieve button or waveform data retrieve button on the
PZ Control menu. To retrieve both types of data, click both buttons.
To save the trend data, see “Saving Trend Data to Files” (page 3-4).

28] pz contral
¥ PZ4000-1
-
r 3
= 4
Single Stanl
Start I
Abort |
Manual Call

Computed value retrieve button
Waveform data retrieve button

IM 253734-61E 2-1
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2.1 Preparations before Loading the Data and Performing Measurements

Starting/Stopping Measurements

3.

Click Single Start to make a single measurement and retrieve the data from the
PZ.

Click Start to make repetitive measurements. The name of the button changes to
Stop.

To stop repetitive measurements, click Stop. To abort the measurement, click
Abort.

PZ Control menu PZ Setting menu
PZ Control PZ Setting
¥ PZ4000-1 Input
Ju et
I~ PE4000-3 L CGE |
I~ Fz4000:4 EEACHiET
: B Display
single Sta#i—1——— Click to perform measurement once and stop. T
Start j——CIick to change the button to Stop and perform
Aport measurements repetitively until the button is —_—
clicked again. __ Printer |
Manual Cal | . Others
Click to abort measurements.
—_
Indicates the data [Reading.
transfer condition | PZ1-Ch2

Selecting the Display Screen

5.

Select the display screen from the View menu bar. The following four types of
screens are available.

File(F) Communications(E} | Wiew(y) ‘Window(\W) Help(H}
Murneric Yalues Monitor(k) k
PZ Cantrol ‘Waveform Window(Ww)
¥ PZ4000-1 Trend Display(T)
- XY Display(x)

Numeric Values Monitor: Displays numeric data that has been computed on the
PZ4000.

Waveform Window: Displays the measured waveform that was retrieved
from the PZ4000 and the waveform that was analyzed
using the software.

Trend Display: Display the trend of the computed data.

X-Y Display: Assigns one of the traces to the X axis to display the
relationship with other traces.

Zero-Level Compensation
For a description of the zero-level compensation, see section 4.4, “Performing Zero-level
Compensation” in the PZ4000 Power Analyzer User’s Manual (IM253710-01E).

6.

Click Manual Cal to carry out zero-level compensation of the PZ.

[=%) Pz contral
¥ PZ4000-1

-

[T FZ4000-3
[T FZa000-4
Single Stanl
Start |
Abort |

Manual CaH———— Click to perform zero-level compensation of the PZ.

d

Trend

2-2
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2.2 Numeric Values Monitor

1. Choose Numeric Values Monitor from the View menu. The Numeric Values

window opens.
Ed PZ24000 Power Yiewer
File(F) Communications(E) | Wiew(y) ‘Window(\W) Help(H}

Murneric Yalues Monitor(k)

2] Pz cantrol WaveForm Window(ih)
¥ PZ4000-1 Trend Display(T)
- XY Display(x)
m Numeric Yalues[PZ4000-1] .—.lglll

Color |

| v

Bemenit1 Bement2

Kejdsig pue juswainsesyy

i

Setting the Text, Line, and Background Colors
2.  Click the Color button at the upper left corner of the Numeric Values window. The
Color Setting dialog box opens.

color setting Y
T[]
Line - Select |
Back - Select |

Ok | Cancel |

3.  Click the Select button corresponding to the item you wish to set. The Color dialog
box opens.

Basic colors:

1T THEERT

Define Custom Calars > |

Cancel |

4.  Click the desired color and click OK.
5.  Click OK on the Color Setting dialog box.
IM 253734-61E 2-3




2.3 Waveform Window

1. Choose Waveform Window from the View menu. The Waveform Window opens.

Dretail

Ed PZ24000 Power Yiewer

File{F) Communications(E) |_\u'iew(\-') window(M)  Help(H}

Mumeric Yalues Monitor(t)

PZ Contral
Display(T}
XY Display(x)

 Positior & Cursor ¢ Zoom | Math | Colar | Mappingl

==700m==

| Zoom Up |Zoom Diowen

| N N N N L (B

Pz

Oms

4000-1_CH [T N N R

Cu

4

rsorl ¥:41.555ms Pz1-C1: 87 4023 Pz1-CZ: 0.0549316A =

4 >

Turning ON/OFF the Waveform Data Display

2. Click the 1 to 8 buttons of PZ4000-* CH to display the corresponding measured
waveform. Click the MATH 1 to 16 buttons to display the waveform that was
analyzed using the software. The buttons corresponding to the channels of which
the waveform data display has been turned ON changes to a brighter green color.
If you click the button again, the waveform is cleared and the color of the button
returns to its original color.

Moving the Waveform Position

3.  Click the Position option button.

4.  Click the waveform you wish to move to highlight the waveform (shown with thick
lines). You can move the position of the waveform vertically by dragging the
waveform in this condition. The upper and lower limits are automatically adjusted.

Cursor (Marker) Operation

5. Click the Cursor option button.

6. On the graph, click the position where you wish to place a marker. A green vertical
cursor appears. The value of the channel at the coordinates and the computed
value analyzed using the software are displayed in the text box below the graph.
Up to two markers can be displayed. To clear a marker, double-click on the graph.

IM 253734-61E



2.3 Waveform Window

Expanding the Waveform Horizontally

7.  Click the Zoom option button.

8.  Specify the range by dragging the mouse over the waveform display range you
wish to expand.

9.  Click the <<Zoom>> button to zoom in on the waveform.

Setting the Cursor Colors

10. Click Color to display the Display Color Settings dialog box.
x|

Cursar |:| Select |
Marker |:| Select |

Cancel |

11. Click the Select button by Cursor or Marker and select the color on the Color
dialog box.

Color

Basic colors:

E
x

11 TTHEENET

Define Custom Calars > |

Cancel |

12. Click OK to close the Color dialog box.
13. Click OK to close the Display Color Setting dialog box.

Expanding/Reducing the Waveform Vertically
14. Click Zoom Up to expand the waveform vertically by a factor between 1 to 10000
in 1-2-4 steps. Click Zoom Down to reduce the waveform vertically.

IM 253734-61E
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2.3 Waveform Window

Detailed Settings of the Waveform Display
1. Click Detail on the Waveform Window to display the Waveform Display Detail

Settings dialog box on which you can set the waveform display in detail.

Use the left half of the Waveform Display Detail Settings dialog box to set the

waveform display of CH1 through CH8.

v PZ4000-1

[T PZ4000-2  [TIFZ4000-3

[~ FZ4000-4

[ Y-Scale ONIOFF

MATH? - 8 | maTHg - 15|

x|

W AutoRange [ Label Divide|1 vl GraticuleIGrid vI

Upper |2|]EII].I]I W Lawer |-2|]F_||].DI W Upper |I] aoor Lowerl 0.000r
I~ CH1 [~ Math1

PDSitiDnlD.DDDDf % Label |C1 Position| 00000 9% LabellMATH1

Upper |1|:| oool A Lower |-1|:| o0ool A Upper ||:| 000l Lowerl 0.0001
[~ CHz [~ Math2

PDSitiDnlD.DDDDf % Lahel |02 Position| 00000 % LabellMATH2

Upper |3|:||:|D_|:u Y Lower |-2EIIJD.EII W Upper ||:| ooai Lowerlll ooai
[~ CH3 [~ Math3

Positionll] 00000 g Label Icg Position| 00000 o Lahel |MATH3

Upper |1|:| oool A Lower |-1|:| o0ool A Upper ||:| 000l Lowerlll 000l
[~ CH4 [~ Math4

Positionll] 00000 o  Label |C4 Position| 00000 o Lahel |MATH4

Upper |D.8|]|]El| W Lower |-D.8|]|]El| W Upper ||] ool Lowerln] noot
[~ CH5 [~ Maths

Positionll] 0000l % Label ICS Paosition| 00000 % Label |MATH5

Upper |U.3I]I][|I A Loweer I-IJ.BIJIJEII A Upper |I] ooi Lowerl'] ooi
[~ CHB [~ Mathé

Positionll] 0000 o Lahel ICG FPosition| 00000 o,  Lahel |MATH6

Upper |5EI 0000 rpm - Lower I-GEI 000l rpm Upper |IJ aoor Lowerlll ool
[~ CH7 [~ Math?

Position | 000000 g Lahel |C? Position| 00000 o, Label |MATH?

Upper |5EI 0000 Nm- Lower [-50.0000 Mm Upper |IJ aoor Lowerlll ool
[~ CHs [~ Maths

Position [ 000000 %  Label [C8 Position| 00000 % Lahel |MATH8

o]

Cancel |

2. Select the PZ4000 (PZ4000-1 to PZ4000-4) to be set in detail using the check box.

Turning ON/OFF the Y-axis Scale
3.  Select the Y-Scale ON/OFF check box to display the upper and lower limits to the

left of the graph.

Waveform Display ON/OFF
4.  Select the check boxes to the left of CH1 to CH8 to turn ON the waveform display.

Setting the Range

5. Enter the upper and lower limits of the graph in the Upper and Lower boxes,
respectively. You cannot set the range, if the AutoRange check box (see step 8) is

selected.

Setting the Display Position

6. To move the displayed position of the waveform vertically, specify the position in
terms of a percentage from the ground level in the Position box. Specify a positive
value to move upward, a negative value to move downward. You cannot set the

position, if the AutoRange check box (see step 8) is selected.

2-6
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2.3 Waveform Window

Setting Waveform Labels and Turning Labels ON/OFF

7. Enter labels for each channel and Math waveforms in the Label text box using up
to eight characters. Select the Label check box to display the entered string on the
graph.

Auto Range Mode
8.  Check the AutoRange check box to enter the auto range mode in which the upper
and lower limits of the graph are automatically set.

Note

If computed data does not exist or when an extremely large value exists in the Math
waveform, the waveform may not appear if displayed in the auto range mode. In such cases,
clear the auto range mode.

Split Screen
9. From the Divide box, select the number of divisions of the graph in the range of 1
to 4.

Grid Style
10. From the Graticule list, select Grid, Frame, or Cross.

Selecting Math

The right half of the Waveform Display Detail Settings dialog box is used to set the
display of computed waveforms that are to be computed by the software (similar to the
waveform settings of CH1 through CH8).

11. Click the Math1-8 or Math9-16 tab containing the appropriate Math channel.
Turning ON/OFF the Waveform Display

12. Select the check boxes to the left of Math1 to Math8 or Math9 to Math16 to
turn ON the waveform display.

Then, set other items by carrying out steps 5 to 10 in a similar fashion.

Exiting the Waveform Display Detail Setting dialog box
13. Click the OK button to close the Waveform Display Detail Setting dialog box.

IM 253734-61E
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2.3 Waveform Window

Waveform Mapping
Mapping refers to the act of assigning waveforms to each graph when using split screen.
By factory default, auto mapping mode is enabled. In auto mapping mode, the
waveforms of CH1, CH2, ..., Math1, Math2 are assigned in order from the first divided
screen skipping the channels that are turned OFF. You can also clear auto mapping and
manually assign the channels.

1. Click Mapping on the Waveform Window to display the Mapping dialog box.
x|

' PZ4000-1 " PZ4000-2 " PZ4000-3 " PZ4000-4

CH1 |1 Vi CH2 |1 VI CH3 |1 VI CH4 |1 vI
CH4 |1 Vi CHE |1 VI CHT |1 VI CHa |1 vl

MATH1-8 | MaTHe-16 |

MATHT |1 »| MATHZ |1 | MATH3 |1 =| MATH4 |1 vI

MATHS |1 Vi MATHE |1 VI MATHT |1 VI MATHS |1 vl

¥ Auto Mapping [o]%¢ I Cancel |

Turning ON/OFF Auto Mapping Mode

2.  Select the Auto Mapping check box to enable auto mapping mode. Clear the
check box to disable auto mapping mode allowing you to manually map the
channels.

Assigning Graphs (Manual Mapping)
3.  Check that auto mapping mode is disabled.
4.  Select the number of the graph for displaying each channel from 1 to 4.

Exiting the Waveform Mapping Settings
5.  Click the OK button to close the Mapping dialog box.

2-8 IM 253734-61E



2.4 Trend Display

1. Choose Trend Display from the View menu. The Trend Display window opens.
File{F) Communications(E) |_\u'iew(\-') window(M)  Help(H}

Mumeric Yalues Monitor(t)

Waveform Window(\W)

¥ PZ4000-1 Trend
XY Display(x)

FZ Control

==70om==

Detail I Zoom Up |Zoom Down

[ & Cursor  Zoom | Calor |

1 PZ1- E2-Urms
1 PZ1- E2-Irms
OFF
QOFF
OFF
QOFF
OFF
QOFF
9. OFF
100FF
110FF
120FF

OO e LTI P O

0 sec ] 544 sec

e 1: 81sec =]
[Tracel] 1:390.098%
[Trace2] 1:11.0233A

]

Note
The trend data is stored on the PC’s hard disk. If the free space on the PC’s hard disk falls
below approximately 200 MB, a disk space error occurs, and measurements and display
updating are stopped.

Trend Display Detail Settings
2. Click Detail to display the Trend Display Detail Settings dialog box. You can
assign the trend of numeric values to be displayed on an arbitrary trace.

Trend Display Detail Settings L _5]

I~ Tracel PZIPZ1 _v__! Element IEIement1 L! UpperID [~ Trace7 Pz!PZ1 vi Element IEIement1 ;j UpperlD
Function IUrms _j Laower I il Function Ildc _v_! Lawer I 1]
I~ Trace2 Pz[PZ1 ~| Element [Elementi =] Upper [0 I~ Trace8 Pz[PZ1 =| Element [Elementi =] Upper [0
Function |Umean _v_l LowerlD Function |Iac Li LowerID
[~ Trace3 leF'Z1 j Element IEIemenh j UpperlD [~ Traced leF'Z1 vi Element |Element1 LI UpperlD
Function IUdc j Lawer | 1] Function |F' L! Lawer | 1]
[~ Traced PZIPZ1 _v__! Element IEIement1 L! UpperID [~ Traceld Pz!PZ1 vi Element IEIement1 ;j UpperlD
Function IUac _j Laower I il Function IS _v_! Lawer I 1]
[~ Traces PZIPZ’] _v_l Element IEIemenh _j UpperlD I~ Traceid PziPZ1 '1 Element IEIemenh _v_! UpperID
Function llrms _v_l Laweer | ] Function |Q Li Laweer I ]
[~ Traced leF'Z1 j Element IEIemenh j UpperlD [~ Tracel2 leF'Z1 vi Element |Element1 LI UpperlD
Function llmean j Lawer | 1] Function |fE L! Lawer | 1]

¥ Auto Range Ok I Cancel |

IM 253734-61E 2-9
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2.4 Trend Display

3.  Select the check boxes to the left of Trace1 to Trace12 to turn ON the display on
the trend display window.

4. From the Pz list of each trace, choose the PZ of which the computed value is to be
output from PZ1 to PZ4.

5. From the Element list of each trace, choose the input element from Element1 to
Element3, Motor, XA, and XB.

6. From the Function list of each trace, select the function such as Urms, Irms, and
A

7. Enter the upper and lower limits of the graph display range in the Upper and
Lower boxes of each trace, respectively. You cannot set the range, if the
AutoRange check box (see step 8) is selected.

Auto Range Mode
8.  Check the AutoRange check box to enter the auto range mode in which the upper
and lower limits of the graph are automatically set.

Cursor (Marker) Operation

9.  Click the Cursor option button.

10. On the graph, click the position where you wish to place a marker. A green vertical
cursor appears. The value of the channel at the coordinates and the computed
value analyzed using the software are displayed in the text box below the graph.
Up to two markers can be displayed. To clear a marker, double-click on the graph.

Expanding the Waveform Horizontally

11. Click the Zoom option button.

12. Specify the range by dragging the mouse over the waveform display range you
wish to expand.

13. Click <<Zoom>> to display the selected range in a separate window.

Setting the Cursor Colors
14. Click Color to display the Display Color Settings dialog box.
x|

Cursar |:| Select |
Marker |:| Select |

Cancel |

15. Click the Select button by Cursor or Marker and select the color on the Color
dialog box.

[ 00 oW

Define Custom Calars »» |

Cancel |
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2.4 Trend Display

16. Click OK to close the Color dialog box.
17. Click OK to close the Display Color Setting dialog box.

Expanding/Reducing the Waveform Vertically
18. Click Zoom Up to expand the waveform vertically by a factor between 1 to 10000
in 1-2-4 steps. Click Zoom Down to reduce the waveform vertically.

Exiting the Trend Display Detail Settings
19. Click the OK button to close the Trend Display Detail Settings dialog box.

IM 253734-61E
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2.5 X-Y Display

1. Choose X-Y Display from the View menu. The X-Y Display window opens.

Ed PZ24000 Power Yiewer

File{F) Communications(E) |_\u'iew(\-') window(M)  Help(H}

Mumeric Yalues Monitor(t)
‘waveform Window(Ww)
Trend Display(T)

(=] pz contral
¥ PZ4000-1

& Cursor ¢ Zoom Calor

| Zoom Up | Zoom Down | ==Zoam==

® 1 Pz1-Ch4

Tracel: Pzl-Ch3

iIfAcE -

firaced ==

iiraced-—

R

iifACER S

THEHERES oo

[iACED

—20.26374 2020264

[Cursor! Pz1-C3] K -4.028320, ¥ -165.161133

X-Y Display Detail Settings
2.  Click Detail in the X-Y Display window to display the X-Y Display Detail Settings

dialog box.
x4
X
pz [PZ1 = chiath [CHT =
~Trace
[~ Tracel Pz [Pz1 =] ohmah [CHI ]
[ Trace2 Pz [Pz1 =] ohmah [CHI ]
[ Trace3 Pz [Pz1 =] chmath [cH 7]
[~ Traced Pz [Pz1 =] chmatn [cHT 7]
[ Traces Pz [Pz1 7| chman [CHI ]
[~ Trace@ Pz [Pz1 7| chman [CHI ]
[ Trace? Pz [Pz1 7| chman [CHI ]
[~ Traces Pz [Pz1 7| chman [CHI ]
Ok I Cancel |
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2.5 X-Y Display

Setting the Waveform Trace of the X-axis
The parameters under X are used to specify the reference trace that is to be assigned to
the X-axis.
3. From the PZ list, select from PZ1 to PZ4 for a PZ channel or Math for Math.
From the Ch/Math list, select from Ch1 to Ch8 or from Math1 to Math16.

Selecting the Y-axis Traces
The parameters under Y are used to specify the reference traces of the Y-axis. You can
select up to eight traces to be displayed on the Y-axis. This excludes the trace that was
selected for the X-axis.
4.  Select the check boxes to the left of Trace1 to Trace8 to turn ON the display on
the X-Y display window. The display is turned OFF by clearing the check boxes.
From the PZ list, select from PZ1 to PZ4 for a PZ channel or Math for Math.
From the Ch/Math list, select from Ch1 to Ch8 or from Math1 to Math16.

Exiting the X-Y Display Detail Settings
5. Click the OK button to close the X-Y Display Detail Settings dialog box.

Cursor (Marker) Operation

6.  Click the Cursor option button.

7. On the graph, click the position where you wish to place a marker. A green vertical
cursor appears. The value of the channel at the coordinates and the computed
value analyzed using the software are displayed in the text box below the graph.
Up to two markers can be displayed. To clear a marker, double-click on the graph.

Expanding the Waveform Horizontally

8.  Click the Zoom option button.

9.  Specify the range by dragging the mouse over the waveform display range you
wish to expand.

10. Click <<Zoom>> to display the selected range in a separate window.

Setting the Cursor Colors

11. Click Color to display the Display Color Settings dialog box.
x|

Cursar |:| Select |
Marker I:l Select |

Cancel |

IM 253734-61E
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2.5 X-Y Display

12. Click the Select button by Cursor or Marker and select the color on the Color

dialog box.

Color

Ll
Rl |
Il |
..
HENN

Custom colors:

[ 0 N
[ W W W

Define Custom Calars »»

17T HEEET ]
11 TTHEREN
11 HEERENT
11 " THEENT

o
Ix

Cancel |

13. Click OK to close the Color dialog box.
14. Click OK to close the Display Color Setting dialog box.

Expanding/Reducing the Waveform Vertically

15. Click Zoom Up to expand the waveform vertically by a factor between 1 to 10000

in 1-2-4 steps. Click Zoom Down to reduce the waveform vertically.

2-14
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Chapter 3

Saving and Loading Data

3.1

Files

Saving Waveform Data, Numeric Values, and
Setup Parameters

Collectively Saving the Setup Parameters, Waveform Data, and Numeric Values to

Saves the setup parameters, waveform data, and numeric values in a single folder.
Choose Save all Items from the File menu.

1.

The Save As dialog box opens.

Ed PZ24000 Power Yiewer

|File(F) Communications(E)  Wiew(t
Load all Items{a)

Save all Ttems(3)

Save Setup(Ll)
Save Waveform Dataiw) 3
Save Mumeric Yalues(E) 3

Save Trend Data ko CVS File
Save Screen to BMP File(B)

Load Setup(L)
savens 20 x|
Save in: |‘;j Drata LI = |‘j( Ed-
8] trddk_.krd
File name: || Save I
Save astype: [PZ4000 All Data file %) = Cancel |
4

Specify the save destination and enter the file name. The extension is not

necessary.

Click Save to save the following files to the specified folder.

Setup parameter file:

Waveform data file name for PZ1:
Waveform header file name for PZ1:
Waveform data file name for PZ2:
Waveform header file name for PZ2:
Waveform data file name for PZ3:
Waveform header file name for PZ3:
Waveform data file name for PZ4:
Waveform header file name for PZ4:
Numeric value file for PZ1:

Numeric value file for PZ2:

Numeric value file for PZ3:

Numeric value file for PZ4:

sample.ast
sample_Unit1.WVF
sample_Unit1.HDR
sample_Unit2. WVF
sample_Unit2.HDR
sample_Unit3.WVF
sample_Unit3.HDR
sample_Unit4. WVF
sample_Unit4.HDR
sample_Unit1.FLD
sample_Unit2.FLD
sample_Unit3.FLD
sample_Unit4.FLD

(The above example assumes that sample was specified for the file name. If there is only a
single PZ, the “_Unit*” section of the name is not attached.)

IM 253734-61E
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3.1 Saving Waveform Data, Numeric Values, and Setup Parameters

Saving Setup Parameters to a File
1.  Choose Save Setup from the File menu.
The Save setup to file dialog box opens.

File(F) Communications(E) Wiew(
Load all Items{a)
Save all tems(S)

Save Waveform Dataiw)

Save Mumeric Yalues(E) 3
Caua Trand Maka ko WS Fila
Save setup to file. |
Save in:laData j = & E-

File name: I Save |
Save as type: IF’Z4DDD Apprication Setup File [*. ast) j Cancel |
4

2.  Specify the save destination and enter the file name. The extension is not
necessary.

3.  Click Save to create a file with specified name with .ast extension and save the
setup parameters.

Note

If you specify the extension for the file name, the extension is discarded, and .ast is added.

Saving Waveform Data to Files
1. From the File menu, point to Save Waveform Data and then choose Save
Waveform Data to WVF File or Save Waveform Data to CSV File.

The Save As dialog box opens.

File(F) Communications(E) Wiew(¥) ‘Window(W) Help(H)
Load all Ikems(a)
Save all Items(s)

Save Setup(Ll)
5a m D orm Data to WYF File
Save Mumeric Yalues(E) 3 Save Waveform Data to CSY File

i:un CSrraan ke BMD FilafBh
savens 21
Save ir: |E‘-J Data j 4= 5 Ef-

File name: |m Save I
Save as type: IF’Z4DDD ‘Wave Data File [*.wvf] j Cancel |
4

2.  Specify the save destination and enter the file name. The extension is not
necessary.

3-2 IM 253734-61E



3.1 Saving Waveform Data, Numeric Values, and Setup Parameters

3.  If you selected Save Waveform Data to WVF File and click Save, the following files

are saved to the specified folder.

Waveform data file name for PZ1: sample_Unit1.WVF
Waveform header file name for PZ1: sample_Unit1.HDR
Waveform data file name for PZ2: sample_Unit2. WVF
Waveform header file name for PZ2: sample_Unit2.HDR
Waveform data file name for PZ3: sample_Unit3.WVF
Waveform header file name for PZ3: sample_Unit3.HDR
Waveform data file name for PZ4: sample_Unit4. WVF

Waveform header file name for PZ4: sample_Unit4.HDR
(The above example assumes that sample was specified for the file name. If there is only a
single PZ, the “_Unit*” section of the name is not attached.)

4. If you selected Save Waveform Data to CSV File and click Save, the waveforms
that are shown on the waveform display (if only CH1 is ON, only CH1) are saved to
the specified folder. In addition, if the waveform is displayed expanded (zoom
function), the waveform in the expanded range is saved to the file. If Math
waveforms are displayed, they are saved to a separate file.

Waveform data file name for PZ1: sample_Unit1.CSV
Waveform data file name for PZ2: sample_Unit2.CSV
Waveform data file name for PZ3: sample_Unit3.CSV
Waveform data file name for PZ4: sample_Unit4.CSV
Waveform data file name for Math:  sample_Analysis.CSV

Note
The waveform data file (.hdr extension) is required when loading the waveform data file (.wvf
extension) using this software program. If the waveform header file does not exist in the
same directory, the waveform data file cannot be loaded.

Saving Numeric Values to Files
1. From the File menu, point to Save Numeric Values and then choose Save
Numeric Values to FLD File or Save Numeric Values to CSV File.

The Save As dialog box opens.
EE PZ4000 Power Yiewer
File(F) Communications(E) Wiew(¥) ‘Window(W) Help(H)

Load all Ikems(a)
Save all Items(s)

Save Setup(Ll)

Save Waveform Data(W)
Save Numetic ' ) o FLD Fl|r-

Save Trend Data ko CVS File Save Mumeric Yalues to CSY Flle

Save Screen to BMP File(B)

savens 21|
Save in: |*.‘j Drata j L |‘j( v
File name: = Save I
Save as type: IF’Z4DDD Mumeric D ata File [%.fld] j Cancel |
P

2.  Specify the save destination and enter the file name. The extension is not
necessary.

IM 253734-61E 3-3

eleq Buipeo] pue buinesg H



3.1 Saving Waveform Data, Numeric Values, and Setup Parameters

3.

If you selected Save Numeric Values to FLD File and click Save, the following files
are saved to the specified folder.

Numeric value file for PZ1:
Numeric value file for PZ2:
Numeric value file for PZ3:

sample_Unit1.FLD
sample_Unit2.FLD
sample_Unit3.FLD

Numeric value file for PZ4: sample_Unit4.FLD
(The above example assumes that sample was specified for the file name. If there is only a
single PZ, the “_Unit*” section of the name is not attached.)

If you selected Save Numeric Values to CSV File and click Save, the following files
are saved to the specified folder.

Numeric value file for PZ1:
Numeric value file for PZ2:
Numeric value file for PZ3:
Numeric value file for PZ4:

sample_Unit1.CSV
sample_Unit2.CSV
sample_Unit3.CSV
sample_Unit4.CSV

Saving Trend Data to Files
The computed values during measurement are saved. The extension for trend data is

Ard.
1.

2.

Click the Trend button on the PZ Control menu.
The Measurement Option dialog box opens.

FZ Control
¥ PZ4000-1

-

[T FZ4000-3
[~ PZ4000-4
Single Stanl
Start |
Abort |

Manual Cal

727 |5

which the trend data is to be saved.

Trend :I—— Click to select the drive and directory in
l

Measurement Option B ll

Flease select a directory to save.

- @00 DELL |
- @D direct
-0 InstallShield Installation Inform

- @0 Internet Explarer
E!I“:I microsoft frontpage
@[3 Modem Helper

-7 Mational Instruments
-1 NetMeeting

-3 Outlook Express
-0 Synaptics

£ Windows Media Player
@£ Windows NT

5[0 Yokogawa

Drrive m

Create Folderl

200 Powerviewer
el
LT wark

LT RECYELED

4[ | _>_|LI Cancel |

Select the destination drive and directory and click OK.
To save to a new directory, click Create Folder. A new folder is created. Change
the folder name.

3-4
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3.1 Saving Waveform Data, Numeric Values, and Setup Parameters

3.  Click the Start button on the PZ Control menu to save the data while making
measurements.

FZ Control
¥ PZ4000-1

-

[T FZ4000-3
™ Pz4000-4
Single Startl {—— Click to save data while performing trend measurements.
start |
Abort |
Manual Call

723
Trend |

The trend data can also be saved to a CSV file.
1. Choose Save Trend Data to CSV File from the File menu.

The Save trend data to CSV file dialog box opens.
File(F) Communications(E) Wiew(
Load all Items{a)
Save all Items(s)

eleq Buipeo] pue buinesg

Save Setup(Ll)
Save Waveform Dataiw) 3

Save Mumeric Yalues(E) 3

Save Trend Data ko CYS File

Save Screen to BMP File(B)

2
Save trend datato Cov e~ Pesong-i S x

@ PZ4000-1 ¢ PZ4000-2 ¢ PZ4000-3 ¢ PZ4000-4
Element! | Elementz | Elements | Elements | Sigmaa | SigmaB |
[~ Urms o T Rp [ Deltalrms
[~ Umean 1 [ *p [~ Delta Imean
™ Ude [~ U+pk I FEE [ Deltaldc
™ Uac I U-pk [~ Eta [~ Deltalac
[~ lIrms ™ l+pk [~ 1iEta
[~ Imean I~ pk | il
™ Idc I~ cf o I™ Speed
™ lac | il I ke [ Targue
o [~ FiJ ™ F4 I Sync
o E [ Fil [~ DeltalUrms [~ Slip
ra = [~ DeltaUmean [~ P
[ Lambda [T Rs [~ Delta Udc [~ Eta A
[~ Phi [ s [~ Deltal) [~ EtamB
Clear All | Close |

2.  Select the PZ for saving the data and select the check boxes for the items to be
saved.
Click Clear All to clear the check boxes of all items.

IM 253734-61E 3-5



3.1 Saving Waveform Data, Numeric Values, and Setup Parameters

3.  Click Save to open the Save trend data to CSV file dialog box.

Save trend data to CS¥ file |
Save in: |{'Eﬂ Data j A |‘j( v

File name: || Save I
Save as type: IESV Files [*.cav) j Cancel |
&

4.  Select the save destination, enter the file name (the extension is not necessary),
and click Save.
5.  Click Close to close the dialog box.

Note
The trend data is stored on the PC’s hard disk. If the free space on the PC’s hard disk falls
below approximately 200 MB, a disk space error occurs, and measurements and display
updating are stopped.

Saving the Screen Image to a File
You can save the screen shot to a file in BMP format.
1. Switch to the screen (window) you wish to save (bring to the front).
2.  Choose Save Screen to BMP File from the File menu.
The Save screen to bitmap file dialog box opens.

File(F) Communications(E) Wiew(
Load all Items{a)
Save all tems(S)

Save Setup(Ll)

Save Waveform Dataiw) 3

Save Mumeric Yalues(E) 3

Save Trend Data ko CVS File
een to BMP File(E)

Load Setunil
Save in: |{'Eﬂ Data j A |‘j( v

File name: I Save I
Save as type: IBitmap File: [* brmp) j Cancel |
&

3.  Select a file name and click Save. The screen image is save to a specified file
name with .omp extension.
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3.2 Loading Waveform Data, Numeric Values, and
Setup Parameters

Collectively Loading Setup Parameters, Waveform Data, and Numeric Values
All the files containing setup parameters, waveform data, and numeric values of the
specified file name are loaded.
1.  Choose Load all ltems from the File menu.

The Open dialog box opens.

|File(F) Communications(E)  View

Save all Items(s)

Save Setup(Ll)
Save Waveform Dataiw) 3
Save Mumeric Yalues(E) 3
Saws Trand Maka ba CWS File
open 21|
Lok in: |‘;H Drata LI = |‘j( Ed-
File name: IE Open I
Filez of type: IF’Z4DDD Apprication Setup File [*. ast) j Cancel |
4
2. Inthe directory containing the files to be loaded, select a file name with .ast
extension.
4.  Click Open to load the following files from the specified directory.
Setup parameter file: sample.ast

Waveform data file name for PZ1:  sample_Unit1.WVF
Waveform header file name for PZ1: sample_Unit1.HDR
Waveform data file name for PZ2:  sample_Unit2. WVF
Waveform header file name for PZ2: sample_Unit2.HDR
Waveform data file name for PZ3:  sample_Unit3.WVF
Waveform header file name for PZ3: sample_Unit3.HDR
Waveform data file name for PZ4:  sample_Unit4. WVF
Waveform header file name for PZ4: sample_Unit4.HDR

Numeric value file for PZ1: sample_Unit1.FLD
Numeric value file for PZ2: sample_Unit2.FLD
Numeric value file for PZ3: sample_Unit3.FLD
Numeric value file for PZ4: sample_Unit4.FLD

(The above example assumes that sample was specified for the file name. If there is only a
single PZ, the “_Unit*” section of the name is not attached.)

Note

» The data of files with the same file name in the directory containing the setup parameter
file (.ast extension) is loaded.
» If the setup parameter file does not exist, the data cannot be loaded.
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3.2 Loading Waveform Data, Numeric Values, and Setup Parameters

Loading Setup Parameter from a File
1. Choose Load Setup from the File menu.
The Load setup from file dialog box opens.

File(F) Communications(E) Wiew(
Load all Items{a)
Save all Items(s)

Load Waveform DatatH)

Load setup from file. |
Look in: |{'Eﬂ Data j A |‘j( v

File name: I Open |
Filez of type: IF’Z4DDD Apprication Setup File [*. ast) j Cancel |

™ Open az read-only

4

2. Select the directory and the name of the file to be loaded.
3.  Click Open to load the selected file.
The setup parameters of the software are set to the contents of the loaded file.

Note
The software can only load setup parameter files with .ast extension. The setup parameter
file of the PZ4000 (.set extension) cannot be loaded into the Power Viewer.

Loading Waveform Data from Files
1. Choose Load Waveform Data from the File menu.

The Open dialog box opens.
'W(F) Communications(E)  Yiewr

Load all Ikems(a)

Save all Items(s)

Load Setupil)
Load ¥ ‘orm DatalH)

I nad Ruraeric Walie R

open (x|

Lok, ir: |*:i Data j 4= &% EB-

File name: Im Open I
Filez of type: IF’Z4DDD ‘Wave Data File [*.wvf] j Cancel |

™ Open az read-only

v
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3.2 Loading Waveform Data, Numeric Values, and Setup Parameters

Note

In the directory containing the files to be loaded, select a file name with .wvf
extension.

Click Open to load the following files from the specified directory.
Waveform data file name for PZ1:  sample_Unit1.WVF

Waveform header file name for PZ1: sample_Unit1.HDR

Waveform data file name for PZ2:  sample_Unit2. WVF

Waveform header file name for PZ2: sample_Unit2.HDR

Waveform data file name for PZ3:  sample_Unit3.WVF

Waveform header file name for PZ3: sample_Unit3.HDR

Waveform data file name for PZ4:  sample_Unit4. WVF

Waveform header file name for PZ4: sample_Unit4.HDR
(The above example assumes that sample was specified for the file name. If there is only a
single PZ, the “_Unit*” section of the name is not attached.)

» This software program can load the waveform data files that have been saved using the
PZ4000 (.wvf extension). However, the header file with the same name (.hdr extension)
must exist in the same directory.

» To load waveform data that has been saved using the PZ4000 into the software, carry out
the steps below.

1. Create a dedicated directory, and copy the files that have been saved using the
PZ4000 (.wvf and .hdr extensions) to that directory.

2. Assign an arbitrary same name to the waveform data file (.wvf extension) and the
header file (.hdr extension).
If you append “_Unit*” to the file name, the data can be loaded as data for the PZ with
the specified number. For example, if you wish to load the data as PZ2 data, append
“_Unit2” to the file name.

Loading Numeric Values from Files

1.

Choose Load Numeric Values from the File menu.

The Open dialog box opens.
'W(F) Communications(E)  Yiewr

Load all Ikems(a)

Save all tems(S)

Load Waveform DatafH)

Load Mureric Yalues(h)
Load Trend DatalR)

open (x|

Lok in: |‘:H Drata LI = |‘j( Ed-

File name: . fld Open I
Files af type: | PZ4000 Numeric Daata File [ fid] = | Cancel |

™ Open az read-only

4

In the directory containing the files to be loaded, select a file name with .fld
extension.

IM 253734-61E
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3.2 Loading Waveform Data, Numeric Values, and Setup Parameters

3.  Click Open to load the following files from the specified directory.
Numeric value file for PZ1: sample_Unit1.FLD
Numeric value file for PZ2: sample_Unit2.FLD
Numeric value file for PZ3: sample_Unit3.FLD
Numeric value file for PZ4: sample_Unit4.FLD
(The above example assumes that sample was specified for the file name. If there is only a
single PZ, the “_Unit*” section of the name is not attached.)
Note

This software program cannot load numeric value files that have been saved using the

PZ4000 (.fld extension).

Loading Trend Data from Files
Choose Trend Display from the View menu. The Trend Display window opens.

1.

ﬁ} Trend Display [

Dretail

Ed 24000 Power Yiewer

File{F) Communications(E) i_\u'iew(\-') window()  Help(H}
Mumeric Yalues Monitor(t)
‘waveform Window(Ww)

FZ Control

v PZ4000-1
-

XY Display(x)

A

=10l x|

Zoarm Up |_3'r_=-:-rr: i:-l:-'-.ﬁ.-'lul ==ZO0Mm== || & Cursor ¢ Zoom | Colar |

0 sec

2650 sec

|

OFF
OFF
OFF
OFF
OFF
OFF
OFF
OFF
9: OFF
10 OFF
11 OFF
12 OFF

OO N L R
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3.2 Loading Waveform Data, Numeric Values, and Setup Parameters

2. Click Detail and set the trace on the Trend Display Detail Settings dialog box. For
details on the procedure, see section 2.4, “Trend Display.”

x|
I~ Tracel leF'Z1 j Element |Element1 j UpperlD [~ Trace7 PzIF'Z1 vI Element |Element1 j UpperlD
Function |Urms j Laower | il Function |Idc j Lawer | 1]
I~ Trace2 Pz[Pz1 v| Element [Element! +| Upper [0 I~ Trace8 Pz[PZ1 =| Element [Elementi =] Upper [0
Function |Umean j LowerlD Function |Iac j LowerlD

[~ Trace3 leF'Z1 j Element |Element1 j UpperlD [~ Traced leF'Z1 vl Element |Element1 j UpperlD g

Function |Udc j Lawer | 1] Function |F' j Lawer | 1] §

[~ Traced leF'Z1 j Element |Element1 j UpperlD [~ Traceld PzIF'Z1 vI Element |Element1 j UpperlD g

Function |Uac j Laower | il Function |S j Lawer | 1] E

[~ Traces lePZ1 j Element |Element1 j UpperlD I~ Traceid lePZ1 vl Element |Element1 j UpperlD a

>

Function |Irms j Laweer | ] Function |Q j Laweer | ] «

o

D

[~ Traceg leF'Z1 j Element |Element1 j UpperlD [~ Tracel2 leF'Z1 vl Element |Element1 j UpperlD S‘
Function |Imean j Lawer | 1] Function |fE j Lawer | 1]

¥ Auto Range Ok I Cancel

3.  Choose Load Trend Data from the File menu.
The Load trend data dialog box opens.

File(F) Communications(E) Wiew(}
Load all Items{a)
Save all Items(s)

Load Mumeric Yalues{N)
Load Trend DatalR)

L e Ly 1 |

x

Flease select a directory.

----- [ ComPlus Applications -]

-0 DELL

-0 direct

-0 InstallShield Installation Infarm

-0 Intel

@23 Internet Explarer Drrive ||§I C: 'l
-2 microsoft frontpage

-0 Madem Helper

- Mational Instruments

----- 3 MetMeeting

----- 23 cutlook Express Create Folderl
- Synaptics

----- [ Windows Media Player

-0 Windows NT

=10 Yokogawa

200 Powerviewer
SEm
€ | o o |

4.  Select the directory containing the file to be loaded and click OK. The file in the
specified directory is loaded, and the trend display is updated.
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Chapter 4

Configuring the PZ4000

4.1

Setting the Input Module

Click the Input button on the PZ Setting menu. The INPUT dialog box opens.
PZ Setting

Input —¢

Acg

Click to open the INPUT dialog box.

Trigger

)
mput x|

@« PZ4000-1  PZ4000-2 € PZ4000-3 ) PZ4000-4

Element1 |Element2| Element3| Element4|

Line Filter IOFF vI Zero Cross Filter | OFF -
Scaling IOFF v! Scaling Factar |1.DDDDDD

—Yoltage

Range IEUUU 'lek Pt Ratio |1.unnnnu

— Current

Terminal |5A vl SensorRatioI1D.DDDDD[ S
Range |1D vI Apk Ct Ratio |1.DDDDDD

Ok I Cancel |

Click the option button corresponding to the PZ4000 (PZ4000-1 to PZ4000-4) you
wish to set.

Selecting the Element

3.

Select the element (Element1 to Element4).

The setup parameters automatically change depending on the type of input module
that you selected.

If you selected the power measurement module, proceed to step 4; if you selected
the motor module, proceed to step 5.

¢ For the Power Measurement Module

4.

Set the following parameters.

Line Filter: Select the input filter from OFF and 500Hz to 1MHz.

Zero Cross Filter:  Select the zero-crossing filter from OFF, 500Hz, and 20KHz.
Scaling: Turn ON or OFF the scaling function.

Scaling Factor: Enter the power coefficient (scaling factor).

Voltage Range: Set the voltage range from 2000 to 30 Vpk and Auto.

Pt Rate: Enter the PT ratio.

Current Terminal:  Set the current input terminal to 5A or Sen. If the input
module is 253752, select from 5A, 20A, Sen.

IM 253734-61E
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4.1 Setting the Input Module

Current Range:

Sensor Ratio:

Ct Ratio:

¢ For the motor module

Select the current range.

If Current Terminal is set to 5A, select the range from 10 to
0.1 Apk and Auto.

If Current Terminal is set to 20A, select the range from 100
to 0.1 Apk and Auto.

If Current Terminal is set to Sen, select the range from 1000
to 100 mVpk and Auto.

Enter the current sensor transformation ratio. The unit is
MV/A.

Enter the CT ratio.

5.  Set the following parameters.

Line Filter:
Zero Cross Filter:

Speed Range:
Scaling:
Sensor Type:

Pulse N:

Frequency Range:

Unit:

Correct:
Torque Range:
Scaling:

Unit:
Pm Scaling:

Unit:

Pole:

Select the input filter from OFF, 100Hz, and 500Hz.
Select the zero-crossing filter from OFF, 100Hz, and
500Hz.

Select the input range of the revolution sensor signal
from 50 to 1 Vpk and Auto.

Enter the scaling coefficient of the revolution sensor
signal.

Set the revolution sensor signal type to Analog or
Pulse.

Enter the pulse count N per rotation when the revolution
sensor signal type (Sensor Type) is set to Pulse.

Select the frequency range from 2k_200kHz to 1_40Hz
and Auto from the drop-down list.

Enter the unit of the rotating speed using up to eight
characters.

Turn ON or OFF the offset correction only when the
rotation sensor signal type (Sensor Type) is set to Pulse.
Select the input range of the torque meter signal from 50
to 1 Vpk and Auto.

Enter the scaling coefficient of the torque meter signal in
the range from 0.0001 to 99999.9999.

Enter the unit of the torque using up to eight characters.
Enter the scaling coefficient of the motor output (Pm) in
the range from 0.0001 to 99999.9999.

Enter the unit of the motor output (Pm) using up to eight
characters.

Enter the motor’s number of poles in the range from 1 to
99.

Sync Speed Source: Select the frequency measurement source (input

Sending the Settings

channel for the voltage or current supplied by the motor)
from CH1 to CHS.

6.  After setting all the parameters, click OK to close the dialog box.

42
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4.2 Setting the Data Acquisition Method (ACQ)

1. Click the ACQ button on the PZ Setting menu. The ACQ[PZ4000-*] dialog box

opens.
PZ Sefting
Input /Click to open the ACQ dialog box.
Acg
Trigger
x
v PZ4000-1 [C PZ4000-2
[T FZ4000-3 - PZ4000-4
Record Length 100k -

Time Base

Record Division |OFF vl
|INT vI
Observation Time |1DDms vI

— ForTime BasebBdt ———

Sampling Rate |1DDDDDD Hz
Ok I Cancel |

2. Select the PZ4000 (PZ4000-1 to PZ4000-4) using the check box.
You can select multiple PZs to specify the same settings.
3.  Set the following parameters.
Record Length: Select the record length to acquire data (ACQ Record Length)
from 100k to 4M. (The selectable range varies depending on
the memory extension option (suffix code /M1 or /M3) of the

PZ.)

Record Division: ~ Select ON or OFF for the record length division.

Time Base: Set the time base clock to INT (internal clock) or EXT (external
clock).

Observation Time: Select the observation time from 10u s to 1ks.

Sampling Rate: Enter the sampling rate. you can enter this value only when

Time Base is set to EXT (external clock).

Sending the Settings
4.  Click the OK button to close the dialog box.
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4.3 Setting the Trigger

1. Click the Trigger button on the PZ Setting menu. The Trigger[PZ4000-*] dialog
box opens.
PZ Setting

’_'”Tt_/ Click to open the Trigger dialog box.

Acg

Trigger :
2

Trigger[PZ4000-1] I x|

[V PZ4000-1 [~ PZ4000-2 [T PZ4000-3 [T PZ4000-4

hode |AU10 'I Source ICH1 'l
Position | 0.000000 % Delay | o.a us
In "

~Type

& Edge © nindow

Slope |Rise vl Condition | r l
Level |D.DDDDDD % Center Level |IZHJ|ZIIZHZIIZI[I %

Width

25000000

%

Ok I Cancel |

2.  Select the PZ4000 (PZ4000-1 to PZ4000-4) using the check box.
You can select multiple PZs to specify the same settings.
3.  Set the following parameters.
Mode: Select the trigger mode from OFF, Auto, AT-Level, Normal, HF Auto,
and HF Normal.
Source: Select the trigger source from CH1 to CH8 or EXT (external trigger signal).
Position: Enter the trigger position in the range of 0.00000 to 100.00000%. The
position valid when Mode is not set to OFF.
Delay: Enter the trigger delay in the range of 0.0 to 1000000.0 u s.
Type:  Set the trigger type to Edge or Window.
If you select Edge, proceed to step 4; if you select Window, proceed to
step 5.

For Edge Trigger
4.  Set the following parameters.
Slope: Set the up and down behavior of the trigger signal from Rise, Fall, amd
Both.
Level:  Enter the reference level of the trigger signal in the range from 0.0 to
+100%

For Window Trigger
5. Set the following parameters.

Condition: Set the trigger condition to In (within the range) or Out (outside the
range).

Center Level: Enter the center level of the window in the range from 0.0 to £100%.

Width: Enter the window width in the range from 0.0 to +200%.

Sending the Settings
6.  Click the OK button to close the dialog box.
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4.4 Setting the Measurement/Computation Periods
(Measure)

1. Click the Measure button on the PZ Setting menu. The Measure[PZ4000-*] dialog
box opens.

PZ Setting

[t
Click to open the Measure dialog box.
Measure:l’

Nisnlay |

Measure[PZ4000-1] I |

¥ PZ4000-1 [C|PZ4000-2 [0 PZ4000-3 [T PZ4000-4 Phase |130|_ead,r|_ag v|
Mode |-:n|\| -I PcFormula  |IECTE-1(1976) =] P |u.500000

P2 |D.SDDDDD
Feriod |Zer0 Cross vI Start Faint I 10.000000 ms
Fattern | Loy State vI End Baint | 490.000000 ms —User Defined

Functiont |OFF vI Unit |V
Sync Source ———————————————— Delta Measure Expression IURMS(E1)
S [OFF [ Function2 [oFF =] ot [A
Element? | CH4 - : Expression ||RMS(E1)
Element3 CHE -

Measure Exec Function3 |OFF vl Unit |V

Elementd CHa -

Expression |UPPK(E1)

Functiond IOFF vI Unit |A
SFormula & Urms®irms ¢ Umean®imean ¢ Udc*lde

Expression ||PPK(E1)

Averaging OFF = Couml2 'I

Ok | Cancel |

2.  Select the PZ4000 (PZ4000-1 to PZ4000-4) using the check box.
You can select multiple PZs to specify the same settings.

Setting the computation period
Set the following parameters.
3. Mode: Select ON or OFF for the computation.
Period: Select the computation region from Zero Cross (zero-crossing region),
Cursor (set the region using cursors), and Ext Trigger (external trigger).
If you select Zero Cross, proceed to step 4; if you select Cursor, proceed
to step 5; if you select Ext Trigger, proceed to step 6.

e When Zero Cross is selected
4.  Set the following parameters.
Sync Source: Set which input signal’s zero crossing to synchronize to for each
element. Select the target signal (synchronization source) from

CH1 to CH8 and Ext (external clock signal).
Note
You can set the Sync Source even in offline mode. For details on the zero cross setting, see
section 10.1, “Setting the Measurement/Computation Period, Re-computing” in the PZ4000
Power Analyzer User’s Manual (IM253710-01E).

e When Cursor is selected
5.  Set the following parameters.
Start Point: Enter the point to start the computation.
End Point: Enter the point to end computations.

The selectable range is 0 to observation time.
IM 253734-61E 4-5

000tzd 8y: Buunbyuo) H




4.4 Setting the Measurement/Computation Periods (Measure)

e When Ext Trigger is Selected
6.  Set the following parameters.
Pattern: Select the signal pattern of the external trigger from the following:
High State (measurement/computation period is the period during which the
external trigger is Hi)
Low State (measurement/computation period is the period during which the
external trigger is Lo)

Selecting the Delta Computation
7.  Select Delta Measure from the following:

OFF: Does not perform delta computation.

ut-u2: Computes the difference between the voltages of element 1 and
element 2.

i1-i2: Computes the difference between the currents of element 1 and
element 2.

3P3W>3V3A: Computes the other data when three-phase, three-wire (3P3W) is
changed to three voltage, three current (3V3A)

Delta>Star: Using the data of three-phase, three-wire system or three voltage,
three current system, computes the star wiring data from the
triangle wiring data.

Star>Delt: Using the data of three-phase, four-wire system, computes the
triangle wiring data from the star wiring data.

Setting the Equation for Apparent Power
8.  Select the equation for apparent power by clicking Urms*Irms, Umean*Imean, or
Udc*Ildc using the S Formula option buttons.

Setting the Averaging Function
9. From the Averaging list, select ON or OFF.
10. From the Count list, select the averaging count from 2 to 64.

Setting the Display Format of the Phase Difference
11.  From the Phase list, select either of the following:
180Lead/Lag: Displays ¢using 180-degree notation by which the counter-clock
wise direction indicates a lead and the clockwise direction
indicates a lag with the positive vertical axis as a reference.
360degrees:  Displays ¢using 360-degree notation in the clockwise direction
with the positive vertical axis as a reference.

Setting the Equation for Corrected Power
12.  From the PC Formula list, select IEC76-1(1976) or IEC76-1(1993).
Enter the coefficients P1 and P2 in the range of 0.0001 to 9.9999.

Setting the User-Defined Function
13.  You can set up to four user-defined functions. The user-defined functions are
entered in Function1 to Function4 under User Defined.
Function:  Select ON (perform computation) or OFF (do not perform computation).
Unit: Enter the unit using up to 8 characters.
Expression: Enter the equation. For details on equations, see chapter 10,
“Numerical Computations” in the PZ4000 Power Analyzer User’s
Manual (IM253710-01E).

Executing Computations
14. Click Measure Exec to transmit the computation command to the PZ4000.

Sending the Settings
15. Click the OK button to close the dialog box.

4-6
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4.5 Setting Numerical Display and Waveform

Display

1. Click the Display button on the PZ Setting menu. The Display[PZ4000-*] dialog

box opens.

PZ Setting

Display

hdath I

Click to open the Display dialog box.

Display[PZ4000-1] C

" FZ4000-1 ¢ FZ4000-2 ¢ FZ4000-3 ¢ PZ4000-4
| Onioff [ Math 1 [ Math 2
All ON All OFF . .
Mapping |D j |1 j
Ch Cchi chz Ch3 Chd Chs Ché ChT cha
onioft icd ird i v v v v v
2 P O P (N EEc 8 Ec O it ) s  E S
Label | CHI | cHz {cH3 { cHa ICHS | cHE | cHr {cHa
Range |2000vpk | [10apk =] 2000vpk w|[10apk | [2000vpk o [10spk | [s0vek o] |sovek v
Terminal - - - - =
(F?urTg:ar}:nalog) A 24 l J |Ana|0g J l J
Position | 0.000 | 0.000 | 0.000 | 0.000 | .000 | .000 | 0.000 | 0.000
Mapping [0 = o = K ~ E =l = = E ~ B =
—Mumeric ave
Itern |8(4) I Format |Sing|e vl Graticule |Grid vl Scale Value |ON vl
Item Semng Interparate |Line vI Mapping IAuto vl Trace Label |OFF vI
—Bar Yector (@ Wurmerc  J—
Function Eletrent ; ~ .
. : - I arker] I 1 j Iarker2 I 13 j UMag IW
e[l A [T =] | oisptavorder [0 :Il Ta [100 :I' iMag [T.000

Close |

2. Select the PZ4000 (PZ4000-1 to PZ4000-4) using the check box.
You can select multiple PZs to specify the same settings.

Setting the Display Mode
3.  From the Format list, select the display mode from the following modes. The
default setting is Numeric+Wave.

Numeric: Numeric display

Wave: Waveform display

X-Y: X-Y display

Numeric+Wave:  Numeric display and waveform display
Numeric+X-Y: Numeric display and X-Y display
Wave+X-Y: Waveform display and X-Y display

IM 253734-61E
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4.5 Setting Numerical Display and Waveform Display

Detailed Settings of the Waveform Display
4.  Enter detailed settings for the traces of CH1 through CH8, Math1, and Math2

waveforms.

On/Off: Select the check box to turn ON the display of each trace.

All ON: Click this button to turn ON the display of all traces.

All OFF: Click this button to turn OFF the display of all traces.

Zoom: Select the vertical zoom factor of each trace in the range of x1 to
x100.

Label: Enter the label of each trace.

Range: Select the range of each trace.

Terminal:  Select the current input terminal from the following:
If the input module is 253752, select from 5A, 20A, Sen.
If the input module is 253754, select from 5A, 20A, Sen, Analog, and
Puise.

Position: Enter the vertical position of each trace in the range of 0.000 to
+130.000%.

Mapping:  Select the mapping method when the waveforms are displayed using
split screens from 0 to 3. For a description of the waveform mapping
method, see section 9.3, “Splitting the Screen and Displaying the
Waveforms” in the PZ4000 Power Analyzer User’s Manual
(IM253710-01E).

Setting Numeric (only when Format is set to Numeric, Numeric+Wave, or
Numeric+X-Y)
5. From the Item list, select the number of items to display from 8(4) to 78(39) and
All
6.  Click Item Setting to display the ltem Setting[PZ4000-*] dialog box.
7.  Set the following parameters.
Item No.:  Set the position to display the item.
Function:  Select the function to be displayed.
Element:  Select the element to be displayed from 1 to 4, £A, and ~B.

Setting Wave (only when Format is set to Wave, Numeric+Wave, or Wave+X-Y)
8.  Set the waveform display style.
Format:  Select the number of split screens from Single, Dual, Triad, and Quad.
Graticule: Select the grid display from Non, Grid, and Cross.
Scale Value: Set the scale display to ON or OFF.
Interpolate: ~ Select Dot or Line for the interpolation method of waveform display.
Mapping: Select the mapping method when the waveforms are displayed on
split screens (see “Waveform Mapping” (page 2-6)) from Auto,
Fixed, and User (enable the mapping settings).
Trace Label: Set the label display to ON or OFF.

Sending the Settings
9.  Click Close to close the dialog box.
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4.6 Setting Math

1. Click the Math button on the PZ Setting menu. The Math[PZ4000-*] dialog box
opens.

PZ Setting

Click to open the Math dialog box.

‘ hath

rorane |

ﬂ

[V PZ4000-1 [~ PZ4000-2 [T PZ4000-3 [T PZ4000-4

Start Point I 0.000 End Paint I 100.000 ms

—MATH1

Function | I Unith

Expressionl 1

Mode |ON vl
ms
OFF =

Sealing  |Auto =] Upper | 100002002 Lower [-10000e+00

—MATH2
Function |OFF vl UnitlA

Expressionl c2

Sealing |Aut0 | Unper | | 0000e+002  Lower |-| 0000e+00;

~FFT

Points |1DDD vi Window |Rect vI
Math Exec | Ok | Cancel |

2.  Select the PZ4000 (PZ4000-1 to PZ4000-4) using the check box.
You can select multiple PZs to specify the same settings.

Setting the Mode
3. Turn ON or OFF the waveform computation mode.

Setting the Computation Region
4.  Set the computation region.
Start Point: Enter the start point.
End Point:  Enter the end point.
The selectable range is 0 to observation time.

Setting the Waveform Equation and Scale Conversion
5.  Set the parameters for each waveform of Math1 and Math2.
Function:  Select ON (perform) or OFF (do not perform) for the computation of
the specified expression.
Expression: Enter the equation. For details on equations, see chapter 11,
“Waveform Analysis” in the PZ4000 Power Analyzer User’s Manual
(IM253710-01E).

Unit: Enter the unit using up to 8 characters.
Scaling: Set the scaling method to Auto (auto scaling) or Manual (manual
scaling).

IM 253734-61E
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4.6 Setting Math

Upper: Enter the upper limit during manual scaling in the range of —
9.9999E+30 to 9.9999E+30.
Lower: Enter the lower limit during manual scaling in the range of —

9.9999E+30 to 9.9999E+30.

Setting the FFT

6.  Set the parameters for the FFT.
Points: Select the number of FFT points in the range of 1000 to 10000.
Window: Set the time window of the FFT to Rect (rectangular) or Hanning.

Executing Computations
7.  Click Math Exec to send the computation start command to the PZ.

Sending the Computation Settings

8.  Click OK to send the setup parameters to the PZ.
The settings become valid by clicking OK and closing the dialog box. Make sure to
validate the settings before sending the computation settings.
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4.7 Setting Cursor Measurements

1.  Click the Cursor button on the PZ Setting menu. The Cursor[PZ4000-*] dialog

box opens.

PZ Setting

Click to open the Cursor dialog box.

‘ Cursar
Fnnm |
x|
v PZ4000-1 [~ FZ4000-2
[~ FZ4000-3 [~ FZ4000-4

Type |Marker vI

Cursaor] Trace CH1 >

Cursor? Trace CH1 i

Cursaor 1 IED.DDDDDD ms
Cursor 2 |SD.DDDDDD ms

Cursor 3 ||]
Cursor 4 II.‘I

Jump Type |+t0 Main vI
Ok I Cancel |

2.  Select the PZ4000 (PZ4000-1 to PZ4000-4) using the check box.
You can select multiple PZs to specify the same settings.

Setting the Cursor Type

3.  From the Type list, select the cursor type.
OFF: Do not display the cursors.
Marker: Markers
Horizontal: Horizontal cursors
Vertical: Vertical cursors
H&V: Horizontal and vertical cursors

Selecting the Target Waveform
4.  Select the target waveform.
Cursor1 Trace: Select the waveform from CH1 to CH8, Math1, or Math2.
Cursor2 Trace: If the cursor type is set to Marker, select the second target
waveform.

Setting the Cursor Position

5. The unit and the number of cursors vary depending on the selected cursor type.

Enter the positions of the cursors in the Cursor1 through Cursor4 boxes.

IM 253734-61E
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4.7 Setting Cursor Measurements

Setting the Jump Type (when Type is set to Marker)

6.  Moves the markers (+/x) to the center of the waveform display frame.
Select the marker you wish to jump and the window from + to Main, + to Z1, + to
22, x to Main, x to Z1, and x to Z2.

Sending the Settings
7.  Click the OK button to close the dialog box.
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4.8 Setting Waveform Zoom

1.  Click the Zoom button on the PZ Setting menu. The Zoom[PZ4000-*] dialog box
opens.
PZ Setting

/Click to open the Zoom dialog box.

Zoom A
Film

=
v/ PZ4000-1 [~ PZ4000-2 [T PZ4000-3° [C PZ4000-4

Mode |Main & Z1| vi
Zoom |Main vI

Allocation

V¥ Chl ¥ Ch2 ¥ Ch3 [¥ Chd All O | All OFF |

W Chd ¥ ChE I Ch7 [# ChE [ Mathl ¥ Math2

Z1 Mag K35 - Z2 Mag

Z1Positior |25.DDDDDD ms Z2

75.000000 ms

Ok I Cancel |

2.  Select the PZ4000 (PZ4000-1 to PZ4000-4) using the check box.
You can select multiple PZs to specify the same settings.

Setting the Mode

3.  Select the zoom display type from Main (number of divisions specified by Format in
“Wave Settings” on page 4-8), Main&Z1, Z1 Only, Main&Z1&Z2, Main&Z2, Z2
Only, and Z1&Z2. For details on the zoom display type, see section 9.8, “Zooming
on the Waveform” in the PZ4000 Power Analyzer User's Manual (IM253710-01E).

Setting Zoom Format (when Mode is set to something other than Main)

4.  Select the number of screen divisions of the zoom display region from Main
(number of divisions specified by Format in “Wave Settings” on page 4-8), Single,
Dual, Triad, and Quad.

Setting Allocation

5.  Select the target waveform using Ch1 to Ch8, Math1, and Math2 check boxes.
Click All ON to select all waveforms at once.
Click All OFF to deselect all waveforms at once.

Setting the Magnification
6.  Set the zoom factor in the range of x2.5 to x100000.

Setting the Position

7. Set the zoom position in the range of 0 to observation time. For details, see
chapter 9.8, “Waveform Analysis” in the PZ4000 Power Analyzer User's Manual
(IM253710-01E).

Sending the Settings
8.  Click the OK button to close the dialog box.

IM 253734-61E
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4.9 Saving the Data and Creating Directories (File)

Saving the Data

File[P24000-1] ] x|

Click the File button on the PZ Setting menu. The File[PZ4000-*] dialog box
opens.
PZ Setting

Input
Click to open the File dialog box.

Printar

File
|
\:

W PZ4000-1 [T PZ4000-2

" FZ4000-3 [T/ FZ4000+4

Save I Ahort
Make Dir |

¥ Auto Maming  File Name |

Iterm |Wave v!
Troe [Bnay =]
Ranat Im
Trace Chi v

Listitern |

Ok | Cancel |

Select the PZ4000 (PZ4000-1 to PZ4000-4) using the check box.
You can select multiple PZs to carry out the same operation.

Setting the File Name
Select the Auto Naming check box to automatically assign file names.

If a single SCSI device is shared among multiple PZ4000s, duplicate file names may occur.
In this case, select the Auto Naming check box.

Click File Name to open a dialog box used to enter the file name and comment.
Enter the file name and comment. Make sure to specify the file name using a full
path starting with the device name.

Example
Floppy disk drive: /FDO/DAT
SCSI device: /SC5/DAT

SCSI device partition 1:  /SC5_1/DAT

Setting the Items to Be Saved
Select the information to be saved from Setup (setup parameters), Wave
(waveform data), or Numeric (numeric values).

4-14
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4.9 Saving the Data and Creating Directories (File)

Setting the Data Type
6.  Select the output format from Binary, ASCII, and Float. If ltem is set to Setup, you
can only select Binary; if ltem is set to Numeric, you can select ASCII or Float.

Setting the Waveform Range to Be Saved (when Item is set to Wave)
7.  Select the waveform range to be saved from Main (main waveform), Z1 (zoom
waveform Z1), and Z2 (zoom waveform Z2).

Setting the Target Waveform (Trace) to Be Saved (when Item is set to Wave and

Type is set to Float)

8. Select the waveform to be saved from Ch1 to Ch8, Math1, and Math2.

9.  Click the OK button to close the dialog box. The settings become valid by clicking
OK and closing the dialog box. Make sure to validate the settings before saving
the data.

Executing the Data Save Operation

10. Click Save to transmit a save command to the PZ4000 to save the data.
Click Abort to transmit an abort command to the PZ4000 to abort the saving of the
data.

Note

It takes approximately eight minutes to save a file from the PZ4000 directly to a SCSI device
(for one PZ4000, 4 Mword/CH, and 8ch).

Creating Directories

1. Click Make Dir to display the Set Directory dialog box.

2. Enter the directory name and click OK. The create directory command is
transmitted to the PZ4000. You can set up to 10 levels of directories.
Example: /SC5/TEST/DATA

IM 253734-61E
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4.10 Printing on the Built-in Printer (Option)

1. Click the Printer button on the PZ Setting menu. The Printer dialog box opens.

PZ Setting

/Click to open the Printer dialog box.
Frinter :

Othars

i
Printer

v PZ4000-1

[~ FZ4000-2
[T PZ4000-3

[ PZAG00-4
Abort |

Close

2.  Select the PZ4000 (PZ4000-1 to PZ4000-4) on which the screen image will be

printed using the check boxes.
You can select multiple PZs to carry out the same operation.

Executing the Print Operation
3.  Click Print to transmit a print command to the PZ4000 to print the PZ4000 screen.
Click Abort to transmit an abort command to the PZ4000 to abort printing.

4.  Click Close to close the dialog box.

IM 253734-61E
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4.11 Setting the Measurement Mode, the Wiring

System, the Number of Displayed Digits, the
Null Function and Initializing Settings

1. Click the Others button on the PZ Setting menu. The Others[PZ4000-*] dialog
box opens.

PZ Setting

Frinter I

Others

x

v PZ4000-1 [~ PZ4000-2

Click to open the Other dialog box.

[~ PZ4000-3 [~ PZ4000-4

Mode INormaI vi
Wiring I1P2W—1P2W vi

FLL Source | CH1 'l
Resolution |5 vl
Mull OFF -

Initialize |
Ok I Cancell

2.  Select the PZ4000 (PZ4000-1 to PZ4000-4) using the check box.
You can select multiple PZs to specify the same settings.

Setting the Mode
3.  The measurement mode is fixed to Normal (normal measurement mode).

Note

This software is designed for the normal measurement mode. There are no functions for the
harmonic measurement mode.

Setting the Wiring System

3. Select the wiring system from 1P2W-1P2W, 1P2W-1P3W, 1P2W-3P3W, 1P3W-
1P2W, 3P3W-1P2W, 3V3A, and 3P4W.
The meanings of the wiring symbols are shown below.
1P2W: single-phase, two-wire, 1P3W: single-phase, three-wire, 3P3W: three-
phase, three-wire, 3V3A: three-voltage, three-current, and 3P4W: three-phase,
four-wire

Setting the Resolution
3.  Set the number of displayed digits to 5 (dgts = display resolution 99999) or 6 (dgts
= display resolution 999999).

Setting the Null Function

3. Turn ON or OFF the NULL function.

Initializing Settings

3.  Click Initialize to initialize the PZ4000 to factory default settings.

Sending the Settings
4.  Click the OK button to close the dialog box. The settings are transmitted to the PZ.

IM 253734-61E
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Chapter 5  Analyzing the Measured Data

5.1 Analyzing Waveforms

You can specify 1 to 16 computations on the software separate from the Math function of

the PZ4000.
1. Choose Waveform Window from the View menu. The Waveform Window opens.

File(F) Communications(E) | Wiew(y) ‘Window(\W) Help(H}
Mumeric Yalues Monitar(t)

FZ Control
[¥ PZ4000-1

Trend Display(T)
XY Display(x)

v
L=

" Positior + Cursor & Zoom | Math | Colar | Mappingl

Detail | Zoom Up |Zoom Down| ==Zoam==

v pEENEEENEDDEEREE
[Pz4000-1 cH IR EN NN R G

eleq painses|\ ayl buizAjeuy

< | 2l
2.  Click Math to display the Analysis dialog box.
xl

MATH? - 8 | maTHg - 15|

MaTH1  [OFF <] unit [Mone
Expressionl

MATHZ OFF = Unit |N0ne
Expressionl

MATH3 OFF = Unit |N0ne
Expressionl

MATH4 OFF = Unit |N0ne
Expressionl

maTHs  [OFF  +| unit [Mone
Expressionl

MATHE OFF = Unit |N0ne
Expressionl

MATHT OFF = Unit |N0ne
Expressionl

MATHS OFF = Unit |N0ne
Expressionl

Analysis Execute | Cancel |
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5.1 Analyzing Waveforms

Selecting Math
2.  The dialog box displays eight items of computations (Math) on each tab. Click the
Math1-8 or Math9-16 tab containing the appropriate computation Math channel.

Setting Math

3. From the Math* list, select ON or OFF.
4.  Enter the unit in the Unit box.
5. Enter the equation in the Expression box.
If there are multiple PZs, enter PZ1 through PZ4 before the channel as in
ABS(PZ1C1).
Example

TREND(PZ1C1)/TREND(PZ2C2)

(PZ1C1: Ch1 of PZ4000-1, PZ2C2: Ch2 of PZ4000-2)
For details on the expressions, see the following table.

A List of Expressions

Operator

Example

Description

Four arithmetic operation

(+, %, = /)

ABS
SQR
SQRT
LOG
LOG10
EXP
NEG
TINTEG
TREND
TRENDF
TRENDM
TRENDD
AVG2

AVG4
AVG16
AVG32
AVGE4
FFT

DIF
ZC

PZ1C1xPZ1C2

ABS(PZ1C1)
SQR(PZ2C1)
SQRT(PZ3C1)
LOG(PZ4C1)
LOG10(PZ1C1)
EXP(PZ2C1)
NEG(PZ3C1)
TINTEG(PZ4C1)
TREND(PZ1C1)
TRENDF(PZ1C1)
TRENDM(PZ1C1)
TRENDD(PZ1C1)
AVG2(PZ1C1*PZ1C2)

AVG4(PZ2C1*PZ2C2)
AVG16(PZ3C1*PZ4C2)
AVG32(PZ1C1*PZ2C2)
AVG64(PZ3C1*PZ4C2)
FFT(PZ1C1)

DIF(PZ1C1)
ZC(PZ1C1)

Four arithmetic operation Four arithmetic operation of
the specified channel data.

If the denominator of a division is 0, the data is set to
the upper limit.

The absolute value of the specified waveform

The square of the specified waveform

The square root of the specified waveform

Natural logarithm of the specified waveform

Common logarithm of the specified waveform

The exponent of the specified waveform

Negation of the specified waveform

The integration of the specified waveform

The trend of RMS values of the specified waveform
The frequency trend of the specified waveform

The trend of Mean values of the specified waveform
The DC trend of the specified waveform

The exponential average with an attenuation constant
of 2 of the specified waveform

The exponential average with an attenuation constant
of 4 of the specified waveform

The exponential average with an attenuation constant
of 16 of the specified waveform

The exponential average with an attenuation constant
of 32 of the specified waveform

The exponential average with an attenuation constant
of 64 of the specified waveform

The FFT of the specified waveform

The differentiation of the specified waveform
Zero-crossing data of the specified waveform

Executing Computations
6. Click Analysis Execute to execute the computations and display the computed
waveforms.
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